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For the Teacher

The activities in this packet are designed to teach students about the reality of living 
on minimum wage.  There is no “set” answer about whether or not it is possible to live 
on minimum wage – a lot of it will depend on the minimum wage in your city, the cost of 
living in your city, and the types of searches your student completes.  Some students 
may view certain categories as “non-negotiables” and wouldn’t consider going without 
Internet, cell phone, their own car, etc.  A lot will depend on the background of a 
student and the comforts he/she is used to.

We hope that by doing these assignments, your students will gain a greater 
appreciation for how difficult it is to live on minimum wage.  This assignment has led 
many of our students to make statements such as, “This really makes me want to go to 
college so that I can get a better job” and “I feel bad asking my parents for money.  I 
never realized how much everything costs.”  We want students to understand that a 
LOT goes into living on one’s own besides just paying the rent.

Before having your students begin this assignment, decide whether or not you want 
students to complete just the assignments, the project (several project ideas are 
included), the presentation, or a combination.  Be sure to pass out the rubric/s so that 
students know what to expect.

When starting this project, be sure to have your students complete the “Before You 
Begin” activity.  This is a great way to check your students’ background knowledge and 
to give a “before and after” snapshot of that learning that occurs. 

The only things that need to be provided to the students are this packet and access to 
the Internet.  If you’d like, you may provide copies of classified ads/newspapers or 
apartment rental magazines.  Make sure students are using REAL evidence for their 
categories, not just random estimates.

We hope you and your students enjoy this packet.  We would love to hear from you 
with comments and suggestions.

If your students enjoy this project, we would recommend our Mock Interview project.  
This project fully prepares students for a mock interview and includes assignments on 
résumé writing, cover letters, job applications, interview tips, and more.

https://www.teacherspayteachers.com/Product/Career-Readiness-Cover-Letter-Resume-Job-Application-and-Mock-Interview-1849654


D I G I T A L  G U I D E

If you would like to move to a paperless classroom or distance-learning    
model for this product, you may do so by clicking on the link on the 

following page. Be sure you are signed into the Google account you would like 
associated with this assignment before clicking.

When the link is clicked, you will immediately be forced to make a copy. This keeps 
the original assignment intact for other buyers.

The student answer keys and interactive notebook activities have already been 
removed, as these have been provided in PDF form for viewing (keys) and printing 
(INB foldable activities). Many people find that a combination of note-sheets, crib 
sheets, and extension activities work best in a digital classroom and that the INB 
activities are more appropriate for paper/pencil-based classrooms.

If you would like to change the order of the slides or delete slides, you may do so 
at this point. Or, you can create an entirely new slideshow. Simply right click to copy 
and then paste any slides into the new slideshow. You can also right click to add a 
new slide. This is perfect for adding in new slides with your own material, links to 
relevant videos, etc.

**Keep in mind that the original slideshow presentation was created as an 8.5x11 inches presentation 
(instead of the traditional Google Slides default size). If you create a new slideshow, you can change the 
default settings by going to File>Page Setup and then clicking on Custom to make an 8.5x11 inch slideshow.

When you are satisfied with your presentation, you can share it with students in 
one of two ways:

CREATE AN ASSIGNMENT IN GOOGLE CLASSROOM (Preferred Method)
Find the assignment/slideshow on your own drive. Make sure you choose the option 
Make a copy for each student so that you are able to view and grade each 
student’s assignment. Be sure your students are signed into their own Google 
accounts before they begin working.

CREATE A SHARABLE LINK
This option allows you to share the assignment with students who don’t have/use 
Google Classroom. You can send the assignment directly to their email, or share it 
in a doc.



D I G I T A L  G U I D E

Most student response spaces in this product already contain a text box, but if 
students find the need to add their own text boxes, they can do this in one of 
two ways:

1. By clicking Insert>Text Box

2. Clicking on the           toolbar icon

At times students may need to circle a response. They can do this by going to: 
Insert>Shape>Circle.

GOOGLE CLASSROOM offers many articles for technical questions such as 
how to submit assignments, how to grade and give feedback, communicating with 
your class, and more. If you are unfamiliar with Google Classroom or have a 
specific question, we encourage you to visit: 

https://support.google.com/edu/classroom

THE DIGITAL LINK FOR THIS PRODUCT IS:

https://docs.google.com/presentation/d/1S12mBSfYQiF9a
e0t3XFdCNGSLZ3LVHaxiHzpfbMHlyo/copy

T E R M S  O F  U S E

• Purchasing this product gives the buyer permission to use the product with his/her 
own class only. It is in violation of the DMCA (Digital Millennium Copyright Act) to 
share this product or any of its contents with a team member, school, or district. 
If you know some one who would like to purchase this product, please refer 
him/her to our store.

• You may not reproduce, redistribute, or post this item on a blog or website for 
download (free or paid). Copying any part of this product, even for a classroom 
website, is also in violation of the DMCA.

• You may not modify, copy, or alter this product in any way.

THANK YOU FOR FOLLOWING OUR TERMS OF USE

Clicking on the           toolbar icon

https://support.google.com/edu/classroom/?hl=en#topic=6020277
https://docs.google.com/presentation/d/1S12mBSfYQiF9ae0t3XFdCNGSLZ3LVHaxiHzpfbMHlyo/copy


Living on Minimum Wage
Before you Begin

Name ________

Answer these questions before you have done any research.  No peeking on the Internet!

What is minimum wage in your city?  $______ per hour.

What is the biggest cost-of-living expense that people incur when living on their own? Ex: food, insurance, 
gas, rent, utilities, entertainment, etc. ____________

Estimate the costs for the following for one month:

Rent (1 bedroom or studio 
apartment in your city)

Gas/Electric

Water

Trash Collection

Phone

TV/Cable

Internet

Car Payment

Car Insurance

Gas (car)

Groceries

Personal Necessities 
(shampoo, razors, etc.)

Incidentals (gifts, books)

Entertainment

Clothes

School Tuition

School Books/Supplies/Fees

Pets (Food/Vet/Care)

Do you think it’s possible to live on minimum wage in your city?  ____
Explain why or why not in as much detail as you can.

__________________________________________

__________________________________________

__________________________________________

__________________________________________

**For the purposes of this assignment, assume that 
all health insurance, dental, and vision costs are 
covered by your employer.  Lucky you!



Rent
Name ________

There are several places you can look to find an apartment:

There are apartment-finder magazines available for free outside of most grocery stores and other 
retail locations.  You may use websites/resources not listed here.

Pretend that you will be living on your own – no roommates, no living with your parents,  and no living 
out of your car.

Find a low-cost (bare-bones), middle-cost (adequate), and high-cost(dream) apartment/studio/loft in 
your current city.  Fill out the chart completely.

LOW ($) MIDDLE ($$) HIGH/DREAM ($$$)

Name of Complex

Link to Website for 
individual apartment*

Location

What is included with 
the rent? (Utilities, 
cable/internet, etc.)

Deposit?  How much?

Amenities (Ex: pool, 
fitness center, 

playground, etc.) 

Would you actually 
consider living here?

Notes/important 
information to 

remember

Cost per month

*If you use resources besides the Internet to find your apartment, please attach the resource/s to 
this page.

http://www.apartments.com/ http://www.apartmentfinder.com/ http://www.forrent.com/

http://www.rent.com/ https://www.craigslist.org/ https://www.apartmentlist.com/

http://www.apartments.com/
http://www.apartmentfinder.com/
http://www.forrent.com/
http://www.rent.com/
https://www.craigslist.org/
https://www.apartmentlist.com/


Transportation
Name ________

There are several places you can look to find a car:

You may use websites/resources not listed here.

Find a low-cost (bare-bones), middle-cost (adequate), and high-cost(dream) car in your current city 
(must be within 100 miles of your address).  Fill out the chart completely.

LOW (Under $5,000) MIDDLE ($5,000-$15,000) HIGH/DREAM ($15,000+)

URL for specific car 
or VIN number

New or Used?

Year

Make

Model

Mileage

List Price (price 
given on website or 
in ad)

*If you use resources besides the Internet to find your vehicle, please attach the resource/s to this 
page.

www.carmax.com https://www.craigslist.org/ www.cargurus.com

www.autotrader.com www.cars.com www.edmunds.com

Cost per month Where did you find this information?

Bus pass (per month)

Other public 
transportation 
(train/trolley/subway)

Public Transportation

http://www.carmax.com/
https://www.craigslist.org/
http://www.cargurus.com/
http://www.autotrader.com/
http://www.cars.com/
http://www.edmunds.com/


Transportation, continued
Name ________

Record the information from the previous page in the table below.

Car 1 - LOW ($) Car 2 - MIDDLE ($$) Car 3 - HIGH/DREAM 
($$$)

List Price (price given 
on website or in ad)

http://www.bankrate.com/calculators/auto/auto-loan-calculator.aspx

You will use the website below to calculate the monthly cost of owning each of the cars above.  
Assume the following for the purposes of this assignment:

• You will not be providing a down payment
• Auto loan term in years: 4 years (48 months)

• Interest rate per year: 3%
• Auto loan start date: Today’s date

**Remember that actual auto loan interest rates fluctuate and depend on whether or not the car is 
new or used, along with other factors.  This estimation tool is to give you an idea of how much three 

types of cars might cost per month.

Car 1 - LOW ($) Car 2 - MIDDLE ($$) Car 3 - HIGH/DREAM 
($$$)

Monthly Car Payment

What did you learn by completing this activity?  Reflect on what you learned and how this information 
might influence your car-purchasing decisions down the road.

__________________________________________

__________________________________________

__________________________________________

__________________________________________

__________________________________________

__________________________________________

http://www.bankrate.com/calculators/auto/auto-loan-calculator.aspx


Car Insurance
Name ________

Use the Internet to research the following questions.  Provide the urls/websites where you found 
your information for each question in the column on the right:

Circle the correct response for each question. Where did you find this information?

Which gender 
pays more for 
car insurance?

Men Women

Which age group 
pays the most 
for car 
insurance?

16-24 25-29 30-39 40-49

Which group pays 
more for car 
insurance?

Married Single

What other
factors influence 
the rate 
someone pays 
for their car 
insurance?  List 
at least 3.

Why do you think there is so much variation in what these different groups of people pay?

__________________________________________

__________________________________________

__________________________________________

Car 1 - LOW Car 2 - MIDDLE Car 3 - HIGH/DREAM 

Male $180 $276 $366

Female $144 $220 $292

To obtain a car insurance quote, companies typically ask for a lot of personal information.  Since you 
are not actually purchasing car insurance, please use the following rate table for your low, middle, and 
high/dream cars.  Remember that your actual car insurance rate would be determined by a multitude of 
factors.  Should you decide to purchase car insurance in the future, be sure to shop around, as rates 

can vary greatly.



Living Expenses: Utilities
Name ________

Utility Cost Per Month Where did you find this information?

Gas/Electric

Water

Trash Collection

Use the Internet to research the costs of the following for 1 person per month (for a 1 bedroom 
apartment) in your city.  Provide the urls/websites where you found your information for each 

category in the column on the right:

Why do some people pay more for gas/electric/water than others?

__________________________________________

__________________________________________

__________________________________________

What can people do to lower their utility costs?

__________________________________________

__________________________________________

__________________________________________



Living Expenses: Groceries

Name ________

Thrifty Low Cost Moderate Cost Liberal

$206 $290 $370 $423

**The following tables include information provided by the USDA (United States Department of 
Agriculture) and have been adjusted to reflect costs for single people living alone.

Males – monthly cost of groceries

Thrifty Low Cost Moderate Cost Liberal

$198 $247 $300 $368

Females– monthly cost of groceries

Inexpensive places to buy 
groceries

Moderately-priced places to 
buy groceries

Expensive places to buy 
groceries

How can people save money on groceries?  You may need to research this topic on the Internet to 
answer the question fully.   List as many ways/ideas as you can think of.

_________________________________________

_________________________________________

_________________________________________

_________________________________________

_________________________________________

Fill in the table below about places in your community.



Living Expenses: Clothing, Pets, and Miscellaneous

Name ________

Category Cost Per Month

Personal necessities (shampoo, razors, etc.)

Incidentals (gifts, books)

School tuition/fees

School books/supplies/fees

Fill out the following table by estimating how much you would spend each month for each category.  
Some categories may not apply to you if you are working a full-time job.  Write the cost for each, or 

put N/A if it would not apply to you.

Inexpensive places to buy 
clothes

Moderately-priced places to 
buy clothes

Expensive places to buy 
clothes

Fill in the table below about places to buy clothes in your city.

Clothes

Miscellaneous

Type of Pet Monthly cost (food, vet, 
medicine, etc.)

Where did you find this information?

Dog

Cat

Pets

Use the Internet to find the average monthly cost for owning a dog and a cat..

Did this information surprise you?  Why or why not?

_________________________________________

_________________________________________



Living Expenses: The Fun Stuff
Name ________

Service Name of 
Company

Cost 
Per 

Month

What is 
Included?

Where did you find this 
information?*

Cable Only
Company #1

Cable Only
Company #2

Internet Only
Company #1

Internet Only
Company #2

Cable/Internet 
Bundle #1

Cable/Internet
Bundle #2

Use the Internet to research the costs of the following services.  Provide the url/website where you 
found your information for each category below:

You may use websites/resources not listed here.

*If you use resources besides the Internet to find these services, please attach the resource/s to 
this page.

Cable/Internet

Service Name of 
Company

Cost 
Per 

Month

What is 
Included?

Where did you find this 
information?*

Cell Phone
Company #1

Cell Phone
Company #2

Cell Phone



Living Expenses: The Fun Stuff, continued

Name ________

Service Cost Per 
Month

Where did you find this information?*

Netflix

Hulu Plus

Amazon Prime

Other Streaming 
Service:

_________

Use the Internet to research the costs of the following services.  Provide the url/website where you 
found your information for each category below:

What do you like to do for fun/entertainment (sports, movies, concerts, etc.)?

_________________________________________

_________________________________________

_________________________________________

Streaming Services

Entertainment 
estimate per 

month $_____

Entertainment (other)

Think about what you like to do for fun that hasn’t already been accounted for.  Estimate the 
monthly cost of entertainment in the table below.



Adding it Up

Name ________

What is minimum wage in your city?  $______ per hour.

The number in the box above is your target number.  When completing the next section, try to stay 
below that number.  If you can’t get below that number, try to get as close as you can.  This may mean 
choosing options that are not the most appealing.  Challenge yourself to stay below your monthly take-

home pay while still completing each mandatory (**) category.

What would be your monthly earnings? 
$______ per hour x 40 (hours per week) x 4 (weeks per month) = $_____

But wait!  Don’t forget to take out money for taxes.  For the purposes of this assignment, let’s assume 
you will be taxed 20% on your monthly earnings.  Actual tax rates vary based on several factors, but 20% 

is a good estimate to use.

Monthly earnings x .80 = $_____    (monthly take-home pay)

Category Describe the option you chose (if applicable).  If 
the item was included in another category, write 
“included with ____”.  If the category does 

not apply or you will not use it, write “N/A.”

Cost Per 
Month

**Rent Low cost apartment – studio located at 
1234 South Street.

$410

**Gas/Electric Included with rent N/A

TV/Cable/Streaming Service Netflix $9

Internet AT&T Basic Internet $30

Pets (Food/Vet/Care) N/A N/A

Example:



Adding it Up, continued

Name ________

Category
** = non-negotiable, must be included

Describe the option you chose (if applicable).  If 
the item was included in another category, write 
“included with ____”.  If the category does 

not apply or you will not use it, write “N/A.”

Cost Per 
Month

**Rent

**Gas/Electric

**Water

**Trash Collection

Phone

TV/Cable/Streaming Service

Internet

**Transportation - Car Payment OR Public 
Transportation (must choose one)

Car Insurance (if car payment was chosen)

Gas (if car payment was chosen)
Assume $20 per week as an estimate

**Groceries

**Personal Necessities (shampoo, razors, etc.)

Incidentals (gifts, books)

Entertainment

**Clothes

School Tuition

School Books/Supplies/Fees

Pets (Food/Vet/Care)

Total cost per month:



Findings

Name ________

After adding up your expenses, were you able to stay below your target number? 

____Yes _____No

Out of all of the categories, what was your biggest expense? _______

In the real-world, do you think you could somehow spend less on this expense?

____Yes _____No

If you answered “Yes”, explain how you could spend less on this expense.  If you answered “No”, explain 
why this expense could not possibly get any lower.

__________________________________________

__________________________________________

__________________________________________

Pros of Living on Your Own Cons of Living on Your Own

Think about the pros and cons of living on your own (on minimum wage).  List three pros and three 
cons in the table below.

Is living on your own easier or harder than you thought it would be?  Explain.

__________________________________________

__________________________________________

__________________________________________



Findings

Name ________

How do you feel about the prospect of living on minimum wage as an adult?  Explain your answer.

__________________________________________

__________________________________________

__________________________________________

Did you find this project valuable?  Why or why not?

__________________________________________

__________________________________________

__________________________________________

__________________________________________

Would you like to make more than minimum wage as an adult?

What would you need to do to get a job that pays more than minimum wage?

__________________________________________

__________________________________________

__________________________________________

____Yes _____No

What did you learn from doing this project that you did not know before?

__________________________________________

__________________________________________

__________________________________________

__________________________________________



Tips for Saving Money

Name ________

Category 1-3 Tips for Saving Money

Rent/Place to Live

Utilities

Transportation

Groceries

Entertainment

Miscellaneous/General Tips for Saving

Fill out the table below.  Give 1-3 specific tips for saving money in each category listed.  Think about 
the types of tips you would give to a friend/family member who was about to move out of their 

parent’s house.

Rent
Utilities

Groceries Cell Phone

Internet

TV/Cable

Transportation

Clothes
Personal Necessities

Circle the categories that you could save money on by getting a roommate:

Streaming Services



Project

Name ________

You will be creating a project to present your findings from the minimum wage exploration.  Talk to 
your teacher to find out which projects are acceptable, and whether or not you will be presenting 
your project to your class/teacher.  

Some project ideas are included below:

Poster

PowerPoint

Prezi

Google Slides Presentation

Other Visual-Media Presentation

Brochure

Website/Blog

Be sure to view the rubric/s to see how you will be graded.  Remember, you need to address all of 
your findings in some way.  It is up to you to determine how to organize your project.  

Some things you may want to include/discuss in your project:

• Your beliefs about living on minimum wage before, during, and after completing the research

• The variation between low, middle, and high cost options (such as rent, car payments, groceries)

• Surprises/new discoveries

• Must haves/essentials vs. extras

• Whether or not you were able to “make it” on minimum wage

• How doing this project has affirmed/changed your thinking 



Project Rubric

Name ________

Unsatisfactory
1

Satisfactory
2

Good
3

Excellent
4

Content Missing several 
components, or 
categories are 
not thoroughly 

explored

Most categories 
are included, but

not all are 
thoroughly 
explored

Most to all 
categories are 
included with 

most 
categories 
being fully 
explored

All categories 
are included and 
are thoroughly 

explored

Organization Project is sloppy 
and/or hard to 

follow

Project shows 
an attempt at 
organization

Project is 
organized

Project is well 
organized and 
easy to follow

Mechanics (Grammar, 
Spelling, Punctuation)

Project contains 
several errors

Project contains 
some noticeable 

errors

Project 
contains a few 

errors

Project contains 
no major errors

Graphics/Visuals/Color Project is not 
visually appealing

Project makes 
an attempt at 

containing
graphics, but 

this is not fully 
developed

Project 
contains some 
graphics/visuals 

that are 
appealing to 
the viewer

Graphics/visuals 
enhance the 
project and 

make it 
appealing to the 

viewer

Overall Effort and 
Effectiveness

Project is not 
effective and is 

not 
representative of 

the student’s 
best work

Project 
demonstrates a 
minimal effort; 
more time could 
have been spent

Project 
displays time
and effort, 

and is 
effective at 

presenting the 
information

Project is high-
quality and 

demonstrates 
the author’s 
best efforts

Your Score/20:



Presentation Rubric

Name ________

Unsatisfactory
1

Satisfactory
2

Good
3

Excellent
4

Content Missing several 
components, or 
categories are 
not thoroughly 

explored

Most categories 
were addressed, 
but not all were 

thoroughly 
explored

Most to all 
categories

were included 
and most were 
fully explored

All categories 
were included 

and were 
thoroughly 
explored

Introduction The presentation 
did not include an

introduction

The
presentation 

had some 
attempt at an 
introduction, 

but it may not 
have been 
effective

The
presentation 

had an 
effective 

introduction

The 
presentation 

had an 
introduction 

that captured 
the audience’s 

attention

Eye Contact The presenter 
looked at notes 
or the project 
without making 

eye contact with 
the audience

The presenter 
occasionally 
looked at 

audience, but 
mostly looked at 
project/notes

The presenter 
looked primarily 

at the 
audience 

throughout
the 

presentation

The presenter 
maintained 
strong eye 

contact 
throughout the 

presentation

Voice The presenter 
was hard to hear 

and/or unclear

Some of the 
presentation 

could be heard 
clearly

Most of the 
presentation
was loud/clear 
enough for 
the audience 

to hear

The presenter
used the volume 
of his/her voice 

effectively 
throughout the 

presentation 
and was easy to 

understand

Conclusion The presenter 
did not attempt 
to wrap up the 
presentation

The presenter 
made some 

attempt at a 
conclusion, but 
it may not have 
been effective

The presenter 
included an 
effective 
conclusion

The 
presentation 
had a strong
conclusion

Your Score/20:



e

Please be sure to visit our store for more 
high-quality teaching products (click on the 
star to follow us).  If you would please take 
a moment to rate your purchase, we would 
greatly appreciate it, and you will receive 
TpT credits towards future purchases!

Thank you for your purchase!
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